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                                  Laboratory Procedure Manual 
  

Analytes:  Diaminochloro-atrazine (DACT), Desethyl-atrazine 
(DEA), Desisopropyl-atrazine (DIA), Hydroxy-atrazine 
(AZN-OH), Desethyl-atrazine mercapturate (DEAM), 
Atrazine mercapturate (ATZ), and Atrazine (AZN) 

     
Matrix:   Urine 

 
     Method:  Atrazine-related Metabolites in Urine  

 
Method No:    6107.01 

  Revised:      
 
 
       As performed by: 

Organic Analytical Toxicology Branch  
Division of Laboratory Sciences 
National Center for Environmental Health 

 
  Contact: 

     Dr. Dana Barr 
              Phone:  770-488-7886 
              Fax:   770-488-7609 
              Email: DBarr@cdc.gov 
 
              Dr. Eric J. Sampson, Director 
              Division of Laboratory Sciences 
 
 

Important Information for Users 
CDC periodically refines these laboratory methods.  It is the responsibility of the user to 
contact the person listed on the title page of each write-up before using the analytical method 
to find out whether any changes have been made and what revisions, if any, have been 
incorporated. 
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1. Clinical Relevance and Summary of Test Principle 
Atrazine (6-chloro N-ethyl-N’-(1-methylethyl)-1,3,5-triazine-2,4-diamine; CAS Number: 
1912-24-9; AZN) is a triazine herbicide that is widely used to kill weeds, primarily on 
crops such as sugarcane, corn, pineapples, sorghum, and macadamia nuts. It has also 
been used on evergreen tree farms, evergreen forest re-growth, highway and railroad 
rights-of-way, and turf application. AZN has been the most used active ingredient in 
agriculture in the United States for nearly two decades, until it was recently replaced by 
glyphosate (EPA 2007). Regardless, the amount of atrazine applied annually has 
remained relatively constant over this time with nearly 80 million pounds applied 
annually.   
 
With the high volume of its application, AZN enters into the environment, particularly in 
soil and water. Its primary degradation can occur via soil bacteria and abiotic processes 
with an environmental half-life of a few weeks to several months (ATSDR 2003 and 
Mandelbaum et al., 1993). AZN and its degradation products tend to migrate out of the 
soil into water systems including surface runoff to streams, river, and lakes, or deep 
ground water systems and aquifers (ATSDR 2003) creating a high potential for human 
exposure. 
 
The metabolites excreted can also be complicated by the exposure scenario (Barr et al. 
2007).  Occupational exposures may allow for more exposure to atrazine itself while 
environmental exposures are likely dominated by exposure to the dealkylated 
environmental degradates that are still presumed to be biologically active if they retain 
the chlorine atom.  Thus, measurement of multiple potential metabolites is necessary to 
accurately assess exposures to atrazine and its related degradates. 
 
Qualitative and quantitative analytical methods have been developed to detect atrazine 
and its metabolites in both human and rat urine (Ikonen et al., 1988; Ademola et al., 
1993; Catenacci et al., 1993; Lucas et al., 1993; Bodalbhia et al., 1998; Gilman et al., 
1998;  Pozzebon et al., 2003; Olsson et al., 2004; Kovivunen et al., 2006; Li et al., 2006; 
Ross and Filipov, 2006; Nguyen et al., 2007). However, most of these methods have 
been limited by the number of metabolites that could be detected, the selectivity of the 
analysis, the sensitivity of the analysis, and/or the complicated pretreatment steps 
required before detection.  To fill this obvious gap in science, we developed a novel, 
highly sensitive, on-line solid phase extraction-isotope dilution-high performance liquid 
chromatography-tandem mass spectrometry (on-line SPE-HPLC-MS/MS) method to 
quantify atrazine and its major metabolites in human urine samples. Our method is 
capable of detecting seven atrazine metabolites with good sensitivity and precision.  In 
addition, by monitoring multiple precursor-product ion pairs, its selectivity is unparalled.  
Furthermore, our method eliminates the need for complicated and time consuming 
sample preparation steps such as derivatization and pre-concentration which typically 
introduce more human error into the measurements.  Our method also provides a cost-
effective analysis allowing us to gather information from a large number of samples.  
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2. Safety Precautions 
 

a. Reagent Toxicity or Carcinogenicity  
Reagents that are necessary to perform this procedure are toxic. Avoid inhalation of or 
dermal exposure to these reagents.  Consult the chemical hygiene plan for the pesticide 
laboratory if any questions about special precautions arise.    

 
b.   Radioactive Hazards 

   None 
   

c. Microbiological Hazards 
Although urine is generally regarded as less infectious than serum, the possibility of 
exposure to various microbiological hazards exists if urine contains visible blood. Take 
appropriate measures to avoid contact with the specimen (see “Protective equipment” 
below. A hepatitis B vaccination series is recommended for laboratorians who are 
exposed to human fluids and tissues. Observe universal precautions. 

 
d. Mechanical Hazards 

Follow standard safety practice while performing this procedure to minimize the risk for 
mechanical hazard. Avoid any direct contact with the electronic components of the mass 
spectrometer unless all power to the instrument has been shut off. Only qualified 
technicians perform electronic maintenance and repair. 

 
e. Protective Equipment 

Use standard personal protective equipment when performing this procedure. Wear a 
lab coat; safety glasses; and appropriate gloves. Use a chemical fume hood when 
preparing the reagents.  

 
f. Training 

Anyone performing this procedure should be trained and experienced in the use of a 
triple-quadrupole mass spectrometer. Although formal training is not necessary,   
personnel are appropriately trained by an experienced operator of the instrument or 
untrained personnel must work under the supervision of a trained person. All personnel 
who operate the instrument must also read all operation manuals.  

 
g. Personal Hygiene 

Use caution when handling any biological specimen. Be sure to use gloves and wash 
hands properly.  

 
h. Disposal of Wastes 

Always dispose of solvents and reagents in an appropriate container clearly marked for 
waste products, and temporarily store them in a flame-resistant cabinet (follow CDC’s  
guidelines entitled Hazardous Chemical Waste Management) Use caution when 
handling containers, glassware, etc., that come in direct contact with the specimens. 
Decontaminate sample preparation surfaces with 10% bleach. Wash the glassware or 
dispose of it in an appropriately labeled autoclave pan. 
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3. Computerization; Data-System Management 
 
a. Software and Knowledge Requirements 

A database named CCEHIP_PSTARS was developed on the CDC/NCEH (SQL server 
2005). The Front-End is Microsoft Access on a DLS-PC network (Q: drive) named 
PSTARS.adp. This database is used to store, retrieve, and analyze data from the 
pesticide-residue analyses. The Statistical Analysis System (SAS) ® software package 
(or their equivalent) is used to maintain the data-management structure.  
 

b. Sample Information 
Sample information can be retrieved from the database (PSTARS). This includes 
sample-identification (ID) number, the notebook number associated with the sample 
preparation, the sample type, the standard number, and any other information not 
associated with the mass-spectral analysis. All sample information will electronically be 
transferred onto mass spectrometer-related-software upon sample analysis. 

 
c. Data Maintanance 

After inputting all sample and analytical data into the database, check for transcription 
errors and overall validity. Back up the database at least once weekly onto a computer 
hard drive. 

 
4. Procedures for Collecting, Storing, and Handling Specimens; Criteria for   

     Specimen Rejection 
 

a. Sample Handling 
Use standard urine collection cups to collect urine specimens from participants. Samples 
should be refrigerated as soon as possible. A minimum of 10 mL of urine should be 
transferred into sterile, 30 mL Qorpak® vials with screw-cap tops. Samples are subject to 
labeling, and are stored at -20˚C or below. Dry ice should be used for shipping. Carefully 
pack vials to avoid breakage during shipment. Store all samples at  -20˚C or -70˚C until 
analysis. 

 
b. Sample Rejection 

Reject specimens with volumes less than 1 mL because they cannot be reliably 
processed.  

  
5. Procedures for Microscopic Examinations; Criteria for Rejecting Inadequately  
Prepared Slides  

          Not applicable for this procedure. 
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6. Preparation of Reagents, Calibrants (Standards), Controls, and All Other Materials;    
Equipment and Instrumentation 

  
a. Reagents and Sources 

    
Table 1 

Reagents and their Manufacturers 
Reagents Manufacturers 

Atrazine (98%) Chemservice  
(West Chester, PA, USA) 

Atrazine mercapturate (98%) Cambridge Isotope laboratory 
(Andover, MA, USA) 

Diamino chloro atrazine (98%) EQ Laboratories 
(Augsberg, Germany) 

Desethyl atrazine (99%) Chemservice (West Chester, PA, 
USA) 

Desethyl atrazine mercapurate (98%) Cambridge Isotope laboratory 
(Andover, MA, USA) 

Desisopropyl atrazine (99%) Chemservice  
(West Chester, PA, USA) 

Hydroxy atrazine (97%) EQ Laboratories 
(Augsberg, Germany) 

(Ethylamine-D5)-atrazine (98%) Cambridge Isotope laboratory 
(Andover, MA, USA) 

(Cysteine 13C3)-atrazine mercapturate 
(98%) 

Cambridge Isotope laboratory 
(Andover, MA, USA) 

(Cysteine 13C3)-diamino chloro 
atrazine (99%) 

Cambridge Isotope laboratory 
(Andover, MA, USA) 

(D6)-desethyl atrazine (99%) EQ Laboratories 
(Augsberg, Germany) 

(Cysteine 13C3)-desethyl atrazine 
mercapurate (98%) 

Cambridge Isotope laboratory 
(Andover, MA, USA) 

(D5)-desisopropyl atrazine (99%) EQ Laboratories 
(Augsberg, Germany) 

(D5)-hydroxy atrazine (98%) EQ Laboratories 
Augsberg, Germany 

Methanol  Tedia Company Inc. 
Formic Acid JT Baker 

Deionized water 
 

NANOpure Infinity ultrapure water 
system 

Nitrogen Gas (99.99%) Airgas, Inc.  

Argon Gas (99.99%) Airgas, Inc.  
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b. Reagent Preparation 
1) Liquid Chromatography Mobile Phases 

Pump 1: Mobile Phase A = 0.3% formic acid in methanol. Prepared by adding 6 mL 
of formic acid into 1994 mL of methanol and mixing well. Mobile Phase B = 0.3% 
formic acid in deionized water. Prepared by adding 6 mL of formic acid into 1994 
mL of deionized water and mixing well.  
 
Pump 2: Mobile Phase A = 0.1% formic acid in deionized water. Prepared by 
adding 2 mL of formic acid into 1998 mL of deionized water and mixing well. Mobile 
Phase B = 0.1% formic acid in methanol. Prepared by adding 2 mL of formic acid 
into 1998 mL of methanol and mixing well.  
 

2) Sample Dilution Reagent 
0.1 % formic acid in aqueous solution. The preparation is done by adding 500 µL of 
formic acid into 499.5 mL of deionized water.  

 
   

c. Standards Preparation 
   

1) Stock Solutions of Analytes  
Individually weigh ≈4 mg of ATZ, AZN, DIA, DEA and DEAM in 10 mL volumetric 
flasks. Add a few milliliters of methanol to the flask and the swirl the flask. Once the 
analytes are dissolved, dilute the contents of the flask to volume with methanol and 
mix. Store the stock solutions in freezer safe vials below 0˚C.  
 
DACT, AZN-OH and ATZ stock solutions are commercially available at 
concentrations of 100 µg/mL.  
 

2) Stock Solutions of Labeled Isotope  
Prepare individual stock solutions of isotopically labeled analogs of ATZ, AZN, 
DACT, and DEAM by adding 1 mg of the analyte in 4 mL methanol into separate 
vials.  Shake to dissolve and store at < 0˚C. 
 
AZN-OH, DIA and DEA stock solutions are commercially available at  
concentrations of 100 µg/mL 

 
3) Labeled Isotope (ISTD) Spiking Solution 

The isotope-labeled standard spiking solution was also prepared in methanol, giving 
an approximate concentration of the individual labeled compounds of 625 ng/mL. 
Once spiked into 1 mL of sample, the concentration yield is 12.5 ng/mL for ATZ, 
AZN, DIA, DEA, DEAM, and AZN-OH.  
 
The exception is made for DACT, the concentration is required for 1,250 ng/mL (25 
ng/mL in 1 mL of sample) 
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4) Native Spiking Standard Solutions 
Nine standard spiking solutions containing AZN-OH, DACT, DIA, DEA, and DEAM 
are prepared by serial dilution with methanol.  The initial stock solutions  cover the 
concentration range of 0.5-200 ng/mL equivalent in 1 mL of urine (i.e., neat 
concentrations ranging 0.025-10 µg/mL).  For AZN and ATZ, the range of 0.2-80 
ng/mL equivalent in 1 mL of urine (i.e., neat concentrations ranging 0.01-4 µg/mL), 
were prepared.  

 
5) Calibration Verification Materials  

CLIA defines calibration materials as "a solution which has a known amount of 
analyte weighed in or has a value determined by repetitive testing using a reference 
or definitive test method."  According to this definition, our quality control (QC) 
materials qualify as calibration verification materials. 

 
6) Proficiency Testing Materials 

Proficiency testing materials are matrix-based samples (typically spiked samples) 
with a known or characterized concentration.  These samples may be spiked or 
have endogenous levels of the target analytes 
 

 
d.  Equipment/Supplies 

 
1) Sartorius Ultramicro® Microbalance (Westbury, NY) 
2) EDP2® pipettes (Rainin Instrument Co. Woburn, MA) 
3) Presterilized filter pipette tips (Rainin) 
4) Vortex Genie® vortex mixer (Scientific Industries Inc., Springfield, MA) 
5) 1.5-mL amber vial (Agilent Tech., Waldbronn, Germany) 
6) Strata-X 25 micron On-line cartridge (Phenomenex, Torrance, CA) 
7) Gemini C6-Phenyl, 3 micron, analytical column (4.6x100 mm) (Phenomenex, 

Torrance, CA) 
8) Gemini C6-Phenyl, 3 micron, analytical column (4.6x50 mm) (Phenomenex, 

Torrance, CA) 
 

   
e.  Instrumentation 

The on-line solid phase extraction-high performance liquid chromatography (On-Line 
SPE-HPLC) is performed on an Agilent 1100 system (Agilent Tech., Waldbronn, 
Germany) consisting of two quaternary pumps, two degassers, an auto sampler with a 
900-µL  injection loop, and a temperature-stable column compartment. An external 10-
port switching values (Agilent Tech., Waldbronn, Germany) is inserted to facilitate the 
column switching performance. All the HPLC modules are programmed and controlled 
using the ChemStation B. 01.03 software (Agilent Tech., Waldbronn, Germany). The 
SPE column is a polymeric Strata-X (20x2.0 mm, 25 μm particle size, 60-Å pore size, 
Phenomenex, Torrance, CA, USA) and the HPLC column is Gemini C6-Phenyl 
(100x4.6 mm, 3 μm particle size, 110-0A pore size, Phenomenex, Torrance, CA, USA) 
for an analysis of ATZ, AZN, DEA, DIA, DEAM, and AZN-OH. A Gemini C6-Phenyl 
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(50x4.6 mm, 3 μm particle size, 110-0A pore size, Phenomenex, Torrance, CA, USA) is 
used separately for an analysis of DACT.  
 
Mass spectrometry analysis is performed on a TSQ Quantum Ultra mass spectrometer 
(ThermoFisher, San Jose, CA) equipped with an atmospheric pressure chemical 
ionization (APCI) interface to generate gas phase ions of the target analytes. The mass 
spectrometer was programmed and controlled using Xcalibur software (ThermoFisher, 
San Jose, CA). The APCI was set in the positive ion mode with the multiple reaction 
monitoring (MRM) setup. 

 
 

7. Calibration and Calibration Verification Procedures 
 
a.  Calibration Plot 

     
1) Construct a 9-point calibration plot (exclusion may happen) by performing a linear 

regression analysis of relative response ratio factor (i.e., area native/area label) 
versus standard concentration.  

 
2) The lowest point on the calibration curve is above the calculated limit of detection 

(LOD) and the highest point is above the expected range of results.  
 

3) Determination of the slope and intercept of this curve is by linear least squares fit 
using SAS® software. 

 
4) R-squared values for the curve must be greater than 0.990. Linearity of standard 

curves should extend over the entire standard range. Intercepts, calculated from 
the least squares fit of the data, should not be significantly different from 0; if they 
are, identify the source of this bias.  

 
5) Periodically or when needed, recalculate the standard curve and re-establish the 

standard curve to incorporate the newest data points.  
 
 

b.  Calibration Verification 
Calibration verification for the overall test system is performed by analyzing three 
concentrations of calibration verification materials (which are included in each run as QC 
materials) in the same manner as unknown samples. The concentrations span the 
useable range of the method but are weighted toward the expected unknown 
concentrations. The overall system is considered calibrated if the calculated 
concentrations are within ±3 standard deviations of the characterized mean values for 
each of the analytes measured in the method. Calibration verification of the overall test 
system is performed with every analytical run. No data are reported unless the overall 
test system passes calibration verification. Calibration results and any significant 
corrective actions are documented either in the PSTARS database or other ancillary 
documents 
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c.  Proficiency Testing 
Proficiency testing should be performed a minimum of once every 6 months. Because no 
formal PT testing program exists for the target analytes of this method, an in-house 
program is used.  This in-house program currently includes pools prepared in-house but 
may also include independently prepared materials whose preparation was contracted 
out to an external laboratory.  Where applicable, NIST matrix-based certified reference 
materials may be included as PT materials. Five randomly selected PT materials will be 
analyzed in the same manner as unknown samples.  These PT materials will be selected 
from among three different concentration ranges spanning the linear range of the 
method.  The concentration range for each sample will be blinded to all analysts.  The 
analytical results are evaluated by an auditor (e.g, branch statistician) who is 
independent of the laboratory performing the analyses.  A passing score is obtained if at 
least four of the five samples fall within the prescribed limits established by the auditor. 
The auditor will notify our laboratory of its PT status (i.e. pass/fail).  If a PT challenge is 
failed, a second attempt to demonstrate proficiency by analyzing a second set of PT 
samples is undertaken.  If the second attempt fails, laboratory operations will cease until 
an appropriate corrective action is taken.  After correction action is taken,    

 
8. Operating Procedures; Calculations; Interpretation of Results  

 
a. Analytical Runs 

Each analytical run consists of 36 unknown urine samples, QCL, QCM, QCH, blank 
urine sample, and nine standard samples.  Remove unknown samples and blank urine 
material from storage freezer and allow them to come to room temperature prior to 
preparation.    

 
b. Sample Preparation 

1) For ATZ, AZN, DEA, DIA, DEAM, and AZN-OH analysis 
 200 µL of urine is pipetted into 1.5 round-bottom amber vial and spiked with 20 µL 

of internal standard solution (ISTD). Samples are diluted with 0.1% formic acid to 
bring the volume to 1 mL. Samples are well mixed prior to analysis. Blank sample is 
also prepared using the same procedure.    

 
2) For DACT analysis 

500 µL of urine is pipetted into 1.5 round-bottom amber vial and spiked with 20 µL 
of internal standard solution (ISTD). Samples are diluted with 0.1% formic acid to 
bring the volume to 1 mL. Samples are well mixed prior to analysis. Blank sample is 
also prepared using the same procedure.    

 
c. On-Line Extraction Conditions 

The operational timetable of the switching program to extract the target analytes from 
urine is given in Tables 6 and 7.  
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Table 6 
Column Switching Program for On-line SPE-HPLC 

For ATZ, AZN, DEA, DIA, DEAM, and AZN-OH analyses 
 

Time 
(min.) 

Description Pump 1 Pump 2 Valve 
Position 

End 

0.00 Sample 
Loading Off 

Isocratic: 100% of 0.1% 
formic acid  
(flow rate 1 mL/min) 

1 To 
waste 

1.50 Sample 
Cleaning  Off 

Isocratic: 90% of 0.1% 
formic acid and 10% of 
0.1% methanolic formic acid 
(flow rate 1mL/min) 

1 To 
waste 

3.00 HPLC 
Separation 

Gradient: 0.3% 
formic acid and 
0.3% methanolic 
formic acid 

Off 2 To 
MS/MS 

23.00 On-line SPE 
Regeneration Off 

Isocratic: 100% of 0.1% 
formic acid  
(flow rate 1mL/min) 

2 To 
waste 

25.00 Switch to 
Sample 
Loading 
Position 

Off Off 1 To 
waste 
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Table 7 

Column Switching Program for On-line SPE-HPLC 
For DACT analysis 

 
Time 
(min.) 

Description Pump 1 Pump 2 Valve 
Position 

End 

0.00 Sample 
Loading Off 

Isocratic: 100% of 0.1% 
formic Acid   
(flow rate 1 mL/min) 

1 To waste

1.50 Sample 
Cleaning Off 

Isocratic: 90% of 0.1% 
formic acid and 10% of 
0.1% methanolic formic 
acid (flow rate 1mL/min) 

1 To waste

3.00 HPLC 
Separation 

Isocratic: 80% of 0.3% 
formic acid and 20% of 
0.3% methanolic 
formic acid  

Off 2 To 
MS/MS 

15.00 On-line SPE 
Regeneration Off 

Isocratic: 100% of 0.1% 
formic acid  
(flow rate 1mL/min) 

2 To waste

17.00 

Switch to 
Sample 
Loading 
Position 

Off Off 1 To waste

 
 
 

d. Liquid Chromatography Conditions 
 

The HPLC separation uses either a stepwise-gradient elution to maximize the 
resolution, or isocratic elution, depending on target compound analysis. HPLC pump 1 
is designated for performing this task.  The combination of 0.3% formic acid and 0.3% 
methanolic formic acid at a given time according to the procedure is shown in Tables 8 
and 9.  
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Table 8 
HPLC Separation 

For ATZ, AZN, DEA, DIA, DEAM, and AZN-OH analysis 
 

Composition Time Flow Rate 
(mL/min.) 0.3% Formic Acid 0.3% Methanolic 

Formic Acid 
0.00 0 80 20 
3.00 0 80 20 
3.01 0.5 80 20 
5.00 0.5 50 50 
9.00 0.5 50 50 

10.00 0.5 20 80 
14.00 0.5 20 80 
15.00 1.0 0 100 
19.00 1.0 0 100 
20.00 1.0 80 20 
23.00 1.0 80 20 
23.01 0 80 20 
25.00 0 80 20 

 
Table 9 

HPLC Separation 
For DACT analysis 

 
Composition Time Flow Rate 

(mL/min.) 0.3% Formic 
Acid 

0.3% Methanolic 
Formic Acid 

0.00 0 80 20 
3.00 0 80 20 
3.01 0.5 80 20 
9.00 0.5 80 20 

10.00 1.0 0 100 
12.00 1.0 0 100 
13.00 0.5 80 20 
15.00 0.5 80 20 
15.01 0 80 20 
17.00 0 80 20 

 
1) Sequence Setup 

Open Chemstation; Instrument 1 (Online) 
• To create a sequence: Choose Sequence > Sequence Table 
• Manually define the following necessary parameters;  

Vial Position→ Enter each individual sample vial position 
Method Name → Enter the specific method associated to target compound 
analysis 
Injection per Location → Enter 1 
Injection Volume → Enter 500 µL     

•    To Save Sequence: Choose Sequence > Save Sequence, then identify 
      the sequence name 
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2) Run the sequence 
• To open a sequence: Click Sequence > Load Sequence 
• Choose specific sequence and then click OK 
• Then click Sequence > Sequence Table  
• On the bottom of the Sequence Table, Click Run Sequence 
• Click the “OK” button when ready to proceed 

 
e. Mass Spectrometry Conditions 

Configuration parameters for this instrument are found in Table 10 and 11. The 
optimized precursor/product ion pairs, as well as the collision off-set energy and 
the retention time for the target compounds, are summarized in Table 12. 
 

Table 10 
MS Configuration 

For ATZ, AZN, DEA, DIA, DEAM, and AZN-OH analysis 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

                       

MS Parameter Setting 

Ionization Type APCI 

Ion Polarity Mode positive ion 

Corona Discharge Current 4.5 µA 

Vaporizer Temperature 350˚C 

Collision Gas Pressure 1.5 torr 

Sheath Gas Pressure 25 psi 

Auxiliary gas 5 

Ion Sweep Gas Pressure 1 psi 

Capillary Temperature 260˚C 
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Table 11 
MS Configuration 
For DACT analysis 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Table 12 
Analyte Masses 

Product Ions 
Analyte 

Precursor 
Ion [M+1] 

Q 
Ion 

C1 
Ion 

C2 
Ion 

Collision 
Energy (V) 
(Q, C1, C2) 

RT* 
(min.) 

Native

AZN-OH 198 86 156 69 23, 16, 35 8.08 

DACT 146 79 68 62 15, 26, 37 6.50 

DEAM 315 185 144 102 12, 23, 37 8.95 

DIA 174 68 132 104 31, 17, 31 10.22 

DEA 188 146 104 110 21, 25, 22 11.95 

ATZ 343 214 102 172 21, 39, 27 11.55 

AZN 216 174 104 68 18, 24, 52 14.62 

Labeled

AZN-OH (D5) 203 161 NA NA 19 8.08 

DACT (D3) 149 113 NA NA 20 6.50 

DEAM 

(Cysteine-13C3; 15N) 319 186 NA NA 20 8.95 

DIA (D5) 179 137 NA NA 21 10.22 

DEA (D6) 194 144 NA NA 21 11.95 

ATZ (Ring-13C3) 346 217 NA NA 19 11.55 

AZN (D5) 221 179 NA NA 19 14.62 
Q = Quantitative ion, C = Confirmative ion-, RT=retention time, NA = not applicable 
*RT can shift within an acceptable range 

MS Parameter Setting 

Ionization Type APCI 

Ion Polarity Mode positive ion 

Corona Discharge Current 5 µA 

Vaporizer Temperature 200˚C 

Collision Gas Pressure 1.5 torr 

Sheath Gas Pressure 15 psi 

Auxiliary gas 5 

Ion Sweep Gas Pressure 1 psi 

Capillary Temperature 260˚C 
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1) Sequence Setup 
Open Xcalibur; Xcalibur allows importing data that has been created by PSTAR 
database 

• To import a sequence: Choose File > Import Sequence  
• Use the Browse button to select the file for import. 
• Select all sequence columns to be included in the sequence file.  
• Click on OK to import the sequence: Xcalibur displays the imported file in 

Sequence Setup  
• Manually define the following parameters;  

File name→ Enter each individual sample file name 
Path → Enter the directory path where the sample’s raw file will be stored;  
Inst. Meth → Enter the path and filename of the instrument method file  

   Position 
   Comments (If needed)  

•    For Save File: Choose File > Save AS 
 

2) Run the sequence 
• Click on the Run Sequence Icon on the tool bar. 
• Check to make sure that the selected rows are displayed in the Run 
     Sequence Dialogue Box. 
• Click Instrument Setting to “Standby” after the sequence has been run at the 

bottom of the Run Sequence Dialogue Box.   
• Click the “OK” button when ready to proceed.   

 
f. Processing data 

To process a batch of samples:  
• Save all selected raw files and sequence file onto a removable drive. 
• Transfer all data onto desktop PC used for data processing 
• Specific sequence associated with target raw files has to be modified by 

identifying “Level” “Path” and “Processing Method” prior data processing   
• Open Quan® browser and select the modified sequence  
• Click Process button      

 
                  

g. Quantification  
• After processing the sample batch, manually evaluate for correct peak  

              detection and baseline selection in the Quan® browser 
• To save the settings in a Quan Browser file (*.XQN). Choose File>Save As 
• Export data files to EXCEL® using the long report format 
• To export data files to EXCEL® → File > Export Excel > Long Report 
• Quan Browser allows the operator to view quantitative results, to evaluate 

standard curve, QCs and unknowns samples, to integrate chromatogram 
peaks manually, and to analyze detailed quantification information.  
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h. Rearrangement of Data Files 
 Data is automatically rearranged into a multiple worksheet (Excel format)® that is 

compatible with our existing database using an Excel® macro. This macro also 
allows for analyst evaluation of quantification and confirmation ions. 

 
i. Transfer of Data 

                  Data is transferred using USB removable drive, floppy disk, or CD-RW disk 
 

j. Importation of Data into Database 
Select “Import new data” option in database.  A password is required to import the 
data. 

 
k. Statistical Analysis and Interpretation of Data 
 See manual procedure 6112.01. 

 
l. Routine and Periodic Maintenance of Key Components 

 
1) Routine Maintenance 

 
1. Mass Spectrometer  
• TSQ Quantum Ultra mass spectrometer undergoes routine maintenance by 

Thermo Scientific Inc. service technicians on a semi-annual basis.  All records 
for this maintenance are kept in a bench side notebook.   

• The daily, weekly or monthly maintenances are under the responsibility of 
operator, which includes cleaning the corona needle, ion transfer tube, 
skimmer, tube lens and Q00.   
 

 
2.  Agilent 1100 HPLC-System 
•  System undergoes routine maintenance by service technicians. All records for 

this maintenance are kept in a bench side notebook.   
• The weekly maintenance is under the responsibility of operator, which includes 

flushing the system with methanol. 
 

2) Periodic  Maintenance 
• In general, these maintenance procedures are performed by instrument 

operator if there is a decrease in the system performance (sensitivity or S/N 
ratio) without any other apparent technical reasons. 

 
                     

9. Reportable Range of Results 
The linear range of the standard calibration curve determines the highest and 
lowest analytical values of an analyte that are reportable. The calibration 
verification of the method encompasses this reportable range.  
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a. Linear Limits 

Analytical standard curves are linear for all analytes through the range of 
concentrations evaluated. The linear range for all analytes is from LOD to 200 
ppb.  

 
b. Analytical Sensitivity 

The detection limits for all analytes are calculated as 3S0, where S0 is the 
estimated standard deviation (SD) at zero concentration and is determined by 
linear regression analysis of the absolute standard deviation (SD) versus 
concentration. The detection limits vary based on the current operating precision 
and the cleanliness of the analytical system. The range of detection limits 
determined to date for the analytes are presented in Table 13. 
 

Table 13 
Analyte Detection Limits 

 
Analyte 3S0 

(ng/ml) 
AZN-OH 0.2 
DACT 2.8 
DEAM 0.4 

DIA 0.3 
DEA 0.5 
ATZ 0.1 
AZN 0.1 

 
 
c. Accuracy 

The accuracy of this method is defined as the degree of agreement between 
the means of measured concentrations of samples and their nominal values.  
The number of samples tested at each concentration is N=5.  Accuracy in this 
method is measured in terms of percent deviation, the percent average 
deviation from spiked concentration. Accuracy is shown in Table 14. 
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Table 14 

Accuracy of the Method 
 

Accuracy 

Mean ± SD (% of expected level) 
 

Analyte 

5 ng/mL 25 ng/mL 50 ng/mL 100 ng/mL 

AZN-OH 5.0±0.4 
(100.8) 

26.5±1.6 
(105.8) 

47.3±1.6 
(94.5) 

96.5±8.9 
(96.5) 

ACT 5.6±0.5 
(112.7) 

25.1±1.2 
(100.4) 

47.8±1.7 
(95.7) 

94.1±6.4 
(94.1) 

DEAM 4.3±0.4 
(86.6) 

25.3±1.3 
(101.1) 

48.3±2.0 
(96.7) 

98.2±6.6 
(98.2) 

DIA 4.9±0.1 
(98.3) 

25.0±1.6 
(100.1) 

48.8±1.9 
(97.5) 

94.6±7.8 
(94.6) 

DEA 5.0±0.2 
(99.5) 

25.3±1.3 
(101.1) 

47.8±1.8 
(95.7) 

97.3±9.3 
(97.3) 

2 ng/mL 10 ng/mL 20 ng/mL 40 ng/mL  

ATZ 2.0±0.0) 
(100.8.) 

10.0±0.3 
(99.7) 

19.0±0.7 
(95.0) 

39.0±2.1 
(97.5) 

AZN 2.0±0.0 
(98.7) 

9.9±0.5 
(98.6) 

19.2±0.8 
(96.1) 

38.2±2.4 
(95.6) 

 
 

d. Precision 
The total precision of this method is determined by calculating the relative 
standard deviation (RSD) of repeat measurements (n=30) of quality control 
materials at three concentrations and includes all sources of variability. Precision 
of the method is shown in Table 15.   

 
Table 15 

Precision (RSD) of the Method 
 

QC Low QC Medium QC High 
Analyte Mean 

(ng/mL) 
RSD% Mean 

(ng/mL) 
RSD% Mean 

(ng/mL) 
RSD% 

AZN-OH 4.9±0.7 14.1 10.4±1.3 12.4 57.7±6.5 11.2 
DACT 5.5±1.1 20.5 12.2±1.4 11.8 64.8±9.1 11.1 
DEAM 5.3±0.8 14.7 11.5±0.9 7.9 57.7±4.8 8.2 

DIA 5.3±0.6 12.1 10.5±0.6 5.3 51.2±4.2 8.3 
DEA 4.7±0.5 10.2 10.0±0.6 5.6 50.6±4.8 9.4 
ATZ 5.1±0.5 9.9 10.5±0.4 4.1 51.8±4.5 8.6 
AZN 5.2±0.5 10.4 11.0±0.7 6.5 55.4±5.2 9.4 

                  RSD= Relative Standard Deviation  
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e. Analytical Specificity 
This is a highly selective method that requires the following of each analyte 
detected: 1) that it elutes at a specific retention time, 2) that it has one precursor 
ion at specific masses, 3) that it has three specific product ions formed from 
each precursor ion at specific masses, and 4) that the ion ratios of the three 
product ions are within a predetermined range.  
 

 
10. Quality Control (QC) Procedures 

 
a. QC Materials 

Quality Control materials for each unknown run are freshly made at the same 
time when samples are prepared.  
 

b. QC Standard Spiking solution 
Three QC standard spiking solutions containing AZN-OH, DACT, DIA, DEA, and 
DEAM is prepared by serial dilution with methanol of the initial stock solutions to yield 
the concentration of 2.5, 12.5, and 30 ng/mL equivalent in 1 mL of urine (i.e., neat 
concentrations are 0.125, 0.625, 1.5 µg/mL).   

 
Similarly, QC standard spiking solutions for AZN and ATZ is prepared by serial 
dilution with methanol of the initial stock solutions to yield the concentration of 1, 
5, and 12.5 ng/mL equivalent in urine (i.e., neat concentrations are 0.050, 0.250, 
0.625 µg/mL)  

 
c. Preparation of QC samples 

For analysis of AZN, ATZ, AZN-OH, DIA, DEA, and DEAM: 200 µL of blank urine is 
pipetted into a 1.5 amber vial and spiked with 20 µL of internal standard solution (ISTD) 
including 20 µL of QC spiking standard. Samples are diluted with 0.1% formic acid to 
bring the volume to 1.0 mL. Samples are well mixed prior to analysis.  
 
For analysis of DACT: 500 µL of blank urine is pipetted into a 1.5 mL amber vial and 
spiked with 20 µL of internal standard solution (ISTD) including 20 µL of QC spiking 
standard. Samples are diluted with 0.1% formic acid to bring the volume to 1 mL. 
Samples are well mixed prior to analysis.  

 
d. Characterization of QC Materials 

Characterize the QC pools (including the blank pool) by 20 consecutive runs (2 
analytical runs per day for 10 days) of each QC material. Use the data from 
these runs to establish the mean and upper-and lower- 99th and 95th control limit.  

 
e. Use of QC Samples  

During each analytical run, three QC materials (QCL, QCM, QCH) are analyzed 
together with unknown samples. 
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f. Final Evaluation of Quality Control Results 
QC materials are evaluated using standard Westgard multirule criteria 
(www.westgard.com).  Repeat out-of-control runs if residual sample is available.   
No data from runs considered out-of-control will be reported. 
 
 

11. Remedial Action If Calibration or QC Systems Fail to Meet Acceptable Criteria 
If the calibration or QC systems fail to meet acceptable criteria, suspend all 
operations until the source or cause of failure is identified and corrected. If the 
source of failure, for example, is a mass spectrometer or a pipetting error, 
correct the problem immediately. Otherwise, prepare fresh reagents and clean 
the mass spectrometer system. Before beginning another analytical run, re-
analyze several QC materials (in the case of QC failure) or calibration 
verification samples (in the case of calibration failure). After re-establishing 
calibration or QC, resume analytical runs.  

 
 

12. Limitations of Method; Interfering Substances and Conditions 
This method is an isotope-dilution mass spectrometry method, which is widely 
regarded as the definitive method for the measurement of organic toxicants in 
human specimens. By using tandem mass spectrometry, most analytical 
interferences are eliminated. However, because of the urinary matrix used in 
this procedure, occasional interfering of unknown substances has been 
encountered.  
 

 
13. Critical-Call Results (“Panic Values”) 

It is unlikely that any result would be a “critical call,” which would only occur with 
poisonings. Typically test results in this laboratory support epidemiological 
studies, rather than clinical assessments. Data is typically used to determine 
chronic exposures.  

 
 

14. Specimen Storage and Handling during Testing 
All samples and standards must remain under freezing temperature prior to use. 
Stability studies suggest that the analytes are stable with 48 hours after 
preparation if samples remain at room temperature.  

 
 

15. Alternate Methods for Performing Test and Storing Specimens If Test 
System Fails 
The method is designed to run on an LC-MS/MS instrument and is not generally 
transferable to other instrumentation. If the system has failed, samples are 
needed to be re-prepared.   
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16. Test-Result Reporting System; Protocol for Reporting Critical Calls  
Once the validity of the data has been established by the Quality Control/Quality 
Assurance system outlined above and has been verified by a DLS QAO, generate 
one hard copy and one electronic copy of the data. Route these data, a cover letter, 
and a table of method specifications and reference range values through the 
appropriate channels for approval (i.e., supervisor, branch chief, division director). 
Once division personnel approve the analytical data, lab chief sends to the contact 
person who requests the analyses. 

 
Report data in support of epidemiological or health survey studies. At this time 
there is not protocol for reporting critical calls.  

 
 
17. Transfer or Referral of Specimens; Procedures for Specimen 

Accountability and Tracking 
Use standard record-keeping systems (i.e., notebooks, sample logs, data files, 
creatinine logs, demographic logs) to keep track of all specimens. Transfer of 
CLIA-specimens is only permitted to certified laboratories. Any transfer of study 
samples is handled through the DLS special studies coordinator. 
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19.  Appendix I: Ruggedness Test 

 
For the ruggedness test, five factors possibly influencing accuracy of analytical method 
were chosen for subsequent test. Those factors were (1) no sample dilution, (2) sample 
with 1:1 dilution using 2% formic acid, (3) sample with 1:2 dilution using 0.1% formic 
acid, (4) sample with 1:2 dilution using 5% formic acid, and (5) sample washing with 
5% formic acid in 50:50/ Water:MeOH during solid phase extraction.   
 
Two replicants of each level of QC materials were used for this experiment. All samples 
were quantified against a standard curve containing nine calibration plots, ranging from 
0.5 to 200 ng/ml including three QC materials (low, medium and high level) that were 
prepared according to the final method described on this Laboratory Procedure 
Manual.  Average calculated concentrations per each level of QC materials of each 
analyte with individual tested factor were obtained.  The accuracy was then calculated 
using the following equation;  
 
Accuracy = 100 x [Calculated concentration with individual tested factor]     
                             [Calculated concentration of final method]    
   
 
Results showing relative accuracy of the seven analytes are shown in the following 
tables. 
 
 

ANALYTE: Diaminochloro-atrazine (DACT) 

INFLUENTIAL FACTORS 
AVERAGE CONCENTRATION 

(ng/ml) 
  Low Level Medium Level High Level 
Final Method 2.55 12.42 30.49
1. Undiluted sample 2.42 12.09 30.40
Relative Accuracy (%): 95.01 97.38 99.71
2. Sample diluted 1:1 with 2% FA 2.64 12.40 29.43
Relative Accuracy (%): 103.65 99.88 96.53
3. Sample diluted 1:2 with 0.1% FA 2.64 11.66 29.38
Relative Accuracy (%): 103.65 93.92 96.36
4. Sample diluted 1:2 with 5% FA 2.04 13.38 30.24
Relative Accuracy (%): 80.09 107.77 99.18
5. SPE washed with 5% FA (v/v) 50:50 H20:MeOH 2.51 12.14 29.68
Relative Accuracy (%): 98.55 97.78 97.35
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ANALYTE: Desethyl-atrazine (DEA) 

INFLUENTIAL FACTORS 
AVERAGE CONCENTRATION 

(ng/ml) 
  Low Level Medium Level High Level 
Final Method 2.43 12.50 29.90
1. Undiluted sample 2.11 10.44 26.32
Relative Accuracy (%): 86.97 83.53 88.01
2. Sample diluted 1:1 with 2% FA 2.44 11.18 27.18
Relative Accuracy (%): 100.58 89.45 90.89
3. Sample diluted 1:2 with 0.1% FA 2.61 11.47 28.44
Relative Accuracy (%): 107.58 91.77 95.10
4. Sample diluted 1:2 with 5% FA 1.98 12.10 30.03
Relative Accuracy (%): 81.62 96.81 100.42
5. SPE washed with 5% FA (v/v) 50:50 H20:MeOH 2.66 11.59 28.45
Relative Accuracy (%): 109.65 92.73 95.14

 
 
 

ANALYTE: Desisopropyl-atrazine (DIA) 

INFLUENTIAL FACTORS 
AVERAGE CONCENTRATION 

(ng/ml) 
  Low Level Medium Level High Level 
Final Method 2.53 12.33 29.37
1. Undiluted sample 2.49 11.34 27.87
Relative Accuracy (%): 98.42 91.99 94.88
2. Sample diluted 1:1 with 2% FA 2.37 11.06 26.69
Relative Accuracy (%): 93.68 89.72 90.87
3. Sample diluted 1:2 with 0.1% FA 2.26 11.05 25.69
Relative Accuracy (%): 89.33 89.64 87.46
4. Sample diluted 1:2 with 5% FA 2.20 12.33 28.33
Relative Accuracy (%): 86.96 100.02 96.45
5. SPE washed with 5% FA (v/v) 50:50 H20:MeOH 2.39 11.20 27.33
Relative Accuracy (%): 94.47 90.86 93.04

 
 
 
 
 
 
 



Atrazine Herbicides                                                                                                       OAT-DLS 
DLS Method Code: 6107.01                                                                 Page 30 of 31 

 

 

 
 

ANALYTE: Desethyl-atrazine mercapturate (DEAM) 

INFLUENTIAL FACTORS 
AVERAGE CONCENTRATION 

(ng/ml) 
  Low Level Medium Level High Level 
Final Method 2.43 11.82 29.72
1. Undiluted sample 2.71 12.05 29.23
Relative Accuracy (%): 111.43 101.95 98.34
2. Sample diluted 1:1 with 2% FA 2.62 11.83 29.18
Relative Accuracy (%): 107.73 100.09 98.17
3. Sample diluted 1:2 with 0.1% FA 2.58 11.68 30.81
Relative Accuracy (%): 106.09 98.82 103.66
4. Sample diluted 1:2 with 5% FA 2.54 14.00 31.68
Relative Accuracy (%): 104.44 118.45 106.58
5. SPE washed with 5% FA (v/v) 50:50 H20:MeOH 2.69 12.32 29.81
Relative Accuracy (%): 110.61 104.24 100.29

 
 

ANALYTE: Hydroxy-atrazine (AZN-OH) 

INFLUENTIAL FACTORS 
AVERAGE CONCENTRATION 

(ng/ml) 
  Low Level Medium Level High Level 
Final Method 2.43 12.00 28.71
1. Undiluted sample 2.18 8.76 24.04
Relative Accuracy (%): 89.86 73.03 83.73
2. Sample diluted 1:1 with 2% FA 2.51 11.25 25.11
Relative Accuracy (%): 103.46 93.79 87.45
3. Sample diluted 1:2 with 0.1% FA 2.42 9.02 22.94
Relative Accuracy (%): 99.75 75.20 79.90
4. Sample diluted 1:2 with 5% FA 2.05 10.40 27.18
Relative Accuracy (%): 84.50 86.70 94.66
5. SPE washed with 5% FA (v/v) 50:50 H20:MeOH ND 10.98 22.54
Relative Accuracy (%): ND 91.54 78.50
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ANALYTE: Atrazine mercapturate (ATZ) 

INFLUENTIAL FACTORS 
AVERAGE CONCENTRATION 

(ng/ml) 
  Low Level Medium Level High Level 
Final Method 0.99 4.90 12.40
1. Undiluted sample 0.82 4.15 9.46
Relative Accuracy (%): 83.25 84.71 76.30
2. Sample diluted 1:1 with 2% FA 0.91 3.94 9.83
Relative Accuracy (%): 92.39 80.42 79.28
3. Sample diluted 1:2 with 0.1% FA 0.88 3.88 9.62
Relative Accuracy (%): 89.34 79.20 77.59
4. Sample diluted 1:2 with 5% FA 0.86 4.29 10.13
Relative Accuracy (%): 87.31 87.57 81.70
5. SPE washed with 5% FA (v/v) 50:50 H20:MeOH 0.92 4.02 9.91
Relative Accuracy (%): 93.40 82.06 79.93

 
 

ANALYTE: Atrazine (AZN) 

INFLUENTIAL FACTORS 
AVERAGE CONCENTRATION 

(ng/ml) 
  Low Level Medium Level High Level 
Final Method 1.01 4.95 12.09
1. Undiluted sample 0.88 4.02 10.93
Relative Accuracy (%): 87.22 81.28 90.42
2. Sample diluted 1:1 with 2% FA 0.95 4.22 10.50
Relative Accuracy (%): 94.15 85.32 86.86
3. Sample diluted 1:2 with 0.1% FA 0.99 4.39 10.87
Relative Accuracy (%): 98.12 88.76 89.92
4. Sample diluted 1:2 with 5% FA 1.04 5.24 12.27
Relative Accuracy (%): 103.07 105.94 101.51
5. SPE washed with 5% FA (v/v) 50:50 H20:MeOH 1.02 4.47 11.19
Relative Accuracy (%): 101.09 90.38 92.57
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